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The Muvipix.com Guide to Photoshop Elements & Premiere Elements 8

Welcome to Photoshop Elements – a terrific, 

affordable photo retouching application 

and graphics editor that just seems to get 

better and more feature-packed with every 

generation!

This is a program that seems to offer more 

wonderful surprises the deeper you dig into 

it. It provides not only the obvious tools for 

cleaning, stylizing and creating images, but 

also lots of not-so-obvious tools for managing 

your image files, outputting a variety of print 

projects and even sharing your work online.

In this chapter, we’ll look at the various 

workspaces in Photoshop Elements 8 – and 

then we’ll dig deeper, looking at the dozens 

of cool tools Adobe has added to make the 

program even more fun to use.

Chapter 2

A Tour of Photoshop Elements 8
What’s what and what it does
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You can access the Inspiration Browser from the link under 
the Help buttons on both the Photoshop Elements Editor and 
Organizer workspaces. If you’re relatively new to Photoshop 
Elements or Premiere Elements or if you just want to improve your 
skills, these tutorials are well worth checking out.

Additionally, your basic Photoshop.com membership includes 
2 gigabytes of online storage space, which you can use to 
automatically back up your computer’s media files. 

With a Plus membership, you have the option of purchasing 20, 40 
or 100 gigabytes of backup space. A Plus membership also gets 
you access to additional content for both Photoshop Elements 
and Premiere Elements as well as even more tutorials.

Once you’ve created an account with Photoshop.com, you can log 
into your account by clicking on the link along the bottom of the 
Welcome Screen  (or on the similar Welcome Screen in Premiere 
Elements). And, once you’ve done this, you will automatically be 
linked to Photoshop.com whenever you launch either program or 
the Organizer, allowing Photoshop Elements, Premiere Elements 
and the Organizer to interact seamlessly with the site as you work.  

We discuss Photoshop.com in more detail in Chapter 32.

By the way, you can re-launch this Welcome Screen 
from any of the Photoshop Elements workspaces at 
any point by clicking on the little house icon in the 
upper right of the Editor and Organizer interfaces.

Launch a Photoshop Elements workspace

There are two major workspaces in Photoshop Elements 8, and 
you can get to either one from the Welcome Screen. 

• The Editor workspace is where you’ll likely do most of your 
photo and image file editing. 

• The Organizer is a media file management program, 
although it also includes tools for cleaning up photos, 
creating photo projects and sharing your photo and video 
projects.

Unlike previous versions of the program, the Organizer is no 
longer a sub-program of Photoshop Elements but its own 
separate file management program, with tools and functions 
shared by both Photoshop Elements and Premiere Elements 8.

We discuss the Organizer workspace in depth in Chapter 31, The 
Organizer.

The Welcome Screen

The Welcome Screen
The Welcome Screen is the option panel that greets you 
whenever you launch the program.

From this screen, you have access to the Organizer or Edit 
workspace as well as a link-up to Photoshop.com, Adobe’s new 
online support service for Photoshop and Premiere Elements.

If you haven’t got an account with Photoshop.com, it’s well worth 
signing up. It costs nothing, and creating an account gets you 
access to a gallery where you can share your photos and enjoy the 
pictures posted by others, as well as free online storage space. 

The site also 
includes the 
Inspiration 
Browser, a library 
of tutorials and 
tips created by 
Adobe and a 
number of other 
content providers 
(including 
Muvipix.com). 
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The Full Edit Workspace

The Full Edit workspace is modeled after the interface in the 
professional version of Photoshop CS4.  Like the current version 
of Photoshop, Photoshop Elements 8 has a cleaner, more modern 
look without any drastic changes to the basic interface. The 
biggest change to the interface is how it displays your open photo 
and image files in the Full Edit workspace.

In earlier versions of the software, any image files you opened 
would appear as “floating” windows, not filling the entire 
workspace panel. If you had several image files open at once, 
these windows would appear piled on top of each other, with the 
photo you were currently editing on the top of the pile. 

In Photoshop Elements 8, you can have the option of displaying all of 
your open photo and image files as a single tabbed set, each photo 
filling the Editor workspace panel, as illustrated below. To switch 
between photo files, you click on the tabs along the top of the panel.

The option to display your files like this, as well as a number of 
other arrangements, is found under the new Arrange menu.

The Editor Workspace

The Editor workspace
The Editor workspace in Photoshop Elements 8 is actually several 
photo editing workspaces, each with its own set of tools and features. 

• The main workspace, which dominates the screen, is the 
Full Edit workspace, which includes a comprehensive photo 
editing and graphics creation Toolbox. This is likely where 
you’ll do most of your editing. 

• If you click on the down arrow to the right of the orange 
Full Edit tab at the top of the Palette Bin, you’ll see that the 
program also offers tools for Quick and Guided Edits. We 
discuss these workspaces in more details in Chapter 3, Quick 
Fixes and Guided Edits.

• Additionally, the Editor workspace includes a great number 
of tools under the Create and Share tabs for doing quick fixes 
and automatic adjustments as well as options for creating 
photo pieces and outputting to a variety of media and 
devices. We discuss the tools in these workspaces and how 
to use them in Chapter 14, Create Fun Photo Pieces and 
Chapter 15, Share Your Photos in Cool Ways.
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The Arrange menu button appears either to the right of the menu 
bar or directly to the right of the blue “pse” logo (depending on 
whether or not you have the program window maximized).  .

As many veteran Photoshop users know, there is an advantage to 
displaying your photos as floating windows rather than a tabbed 
set. When your files are displayed as floating windows, you can 
copy images, portions of images and even entire layers from one 
image file to another simply by dragging these elements from one 
open file to another.  (This function comes in handy when you’re 
creating or modifying Premiere Elements DVD and BluRay menu 
templates, as we discuss in Chapter 33, Use Photoshop Elements 
and Premiere Elements Together.)

There are two ways to switch between displaying your photos as a 
docked, tabbed set and displaying them as floating windows:

• Set the Arrange menu to Float All Windows. When you set the 
Arrange drop-down menu to Float All Windows, all of your 
photo files will display as more traditional floating windows.

• Undock a photo from the tabbed set by dragging on its 
tab. When you pull the photo file by its tab from the others in 
a tabbed set, it becomes a floating window. 

 The one disadvantage to creating a floating window this way 
is that floating windows always float over your tabbed photo 
files. This means that, in order to get to the other photos 
in your docked set, you will have to either minimize your 
floating window or move it out of the way!

To dock or re-dock a photo into a tabbed set, simply drag the 
floating window by its docking header (the top of the window) 
onto another open photo or tabbed set. When the photo file 
becomes semi-transparent (as illustrated on the previous page) 
release your mouse button and the photo will dock to the set.

Guides

A welcome, new feature that version 8 borrows from its big 
brother, Photoshop CS4, is the ability to display Guides over your 
image files. These horizontal and vertical lines don’t show up on 
your final piece, of course. But they can be a great help for placing 
elements and text and ensuring that they are properly lined up.

To create a Guide, click and drag across the Rulers running along 
the tops and sides of your image files. (If you don’t see your Rulers, 
you can select the option to display them from View drop-down 
on the Menu Bar.)

To toggle between displaying and hiding these guides on your 
image files press Ctrl+; on your keyboard.

The Menu Bar

Along the top of the interface is the Menu Bar, which gives you 
access to both basic program functions (Save, Edit, Paste, etc.) 
and advanced image manipulation and selection functions – all of 
which we discuss in greater detail in subsequent chapters.

New Editor Workspace Features
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To the top right of this Menu Bar you’ll find a number of other 
buttons, as illustrated above: 

• The Photoshop.com link. If you’ve signed up for and 
logged in to Photoshop.com, you’ll find a quick link here 
to your online account. (This will be displayed as the words 
“Welcome” and your name.) Clicking this button (you’ll 
be prompted for your password) brings up your account 
profile and information on your online storage space. 
In Chapter 32, Photoshop.com, we’ll show you how to set 
up your account to automatically back up your media files 
online.

• Undo/Redo and Undo History. To the right of this quick link, 
you’ll find the Undo and Redo buttons. Photoshop Elements, 
like Premiere Elements, includes a virtually unlimited 
number of Undos. (By default, the program will save 50 
undo’s, although you can optionally set your Preferences to 
save as many as 1,000.) By clicking this button (or pressing 
Ctrl+z on your keyboard) you can undo anything you’ve 
done, one step at a time, all the way back to the point at 
which you opened your image file. To step forward again and 
redo your undo, click the Redo button (or press Ctrl+y on 
your keyboard). (You can change it to the more traditional 
Ctrl+Shift+z in the program’s Preferences, by the way.)

 For quick access to any Undo point in your work, go to the 
Window drop-down on the Menu Bar and open the Undo 
History palette. This palette lists every action you’ve taken 
on your image file since opening it, and when you click to 
select any point listed, your image file will instantly revert to 
that point in your work.

• The Organizer launch button. Finally, in the upper right of 
the Editor workspace is a quick-launch button that opens the 
Photoshop Elements Organizer.

The Toolbox

Along the left side of this workspace is the program’s Toolbox. 
The tools in this panel serve a number of functions, from selecting 
areas in your image file to creating graphics and text to patching 
and cloning areas of your images. As each tool is selected, that 
tool’s individual settings are displayed in the Options Bar that 
runs along the top of the editing workspace.

We’ll spend considerable time getting to know these powerful 
tools and how to use their settings and options in Chapter 4, The 
Photoshop Elements Toolbox. 

The Palette Bin

To the right of the editing workspace is the Palette Bin, which 
includes a number of tools and palettes which vary, depending 
on whether you’ve selected the Full Edit, Quick Fix, Guided Edit, 
Create or Share tab, as illustrated below. (You’ll see similar tabs 
both in the Organizer and in Premiere Elements.) 

The Palette Bin
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In Full Edit mode, this bin includes, by default, the Layers and the 
Effects palettes. However, if you click on the Window drop-down 
in the menu bar at the top of the interface, you’ll find options to 
open (or close) nearly a dozen palettes, all of which can either 
“float” over the interface or can be dragged into and “docked” in 
the Palette Bin.

We discuss in detail how to use the various tools under each 
of these tabs in Chapter 3, Quick Fixes and Guided Edits, 
Chapter 14, Create Fun Photo Pieces and Chapter 15, Share 
Your Photos in Cool Ways.

The Project Bin
Running along the bottom of the Editor workspace is a small but 
powerful panel known as the Project Bin. 

By default, all photos and image files you have open in your Editor 
workspace will appear as thumbnails in this bin. 

To bring an open file to the front in your Full Edit workspace, 
double-click on its thumbnail in the Project Bin.

However, although this is the default and most common way to 
use the Project Bin, it is certainly not its only function. The Project 
Bin also interfaces with a number of other workspaces. 

To access and change the Project Bin’s display options, click on the 
bin’s drop-down menu, which reads Show Open Files by default, 
as in the illustration above.

Show Open Files. Displays, as thumbnails, all of the image files 
you currently have open in your Editor workspace.

Show Files from Organizer. If you’ve got the Organizer open 
and you have files selected in its Photo Browser area, selecting 
this option displays those files in the Project Bin. These photos 
or image files can then be launched in the Editor workspace by 
double-clicking on them.

Albums. If you have Albums created for your image files in the 
Organizer, these Albums will also be listed on this drop-down 
menu, and their images can be accessed as a group. To learn more 
about creating Albums, see Chapter 31, The  Organizer.

A second drop-down menu in the Project Bin accesses a number 
of Bin Actions, which can be applied to the image files appearing 
in the bin.

Create. Launches the tools listed under the Create tab. We 
discuss how these tools work in Chapter 14, Create Fun Photo 
Pieces.

Share. Launches the tools and options listed under the Share 
tab. We discuss how these tools work in Chapter 15, Share Your 
Photos in Cool Ways.

Print Bin Files. Sends all of the images in your Project Bin to 
your printer.

Save Bin as Album. Creates an album of whatever files you 
currently have in your Project Bin. This new album will then 
appear in the file management system in the Organizer.

The Project Bin also serves as an asset pool for many Create and 
Share tools. When, for instance, you create a Photo Book or an 
Online Album, the photos that are currently open in the Project 
Bin will automatically be added to this new photo piece. 

We discuss how the files in the Project Bin function with these 
tools in Chapter 14, Create Fun Photo Pieces, and in Chapter 15, 
Share Your Photos in Cool Ways.

The Organizer
Modeled after Adobe’s Bridge program, the Organizer is a 
powerful file management program for cataloging, searching and 
organizing your media files. In addition to its file management 
tools, the Organizer offers a number of Quick Fix editing tools as 
well as tools for creating, sharing and editing your media in both 
Photoshop Elements and Premiere Elements. 

Many of these same tools are also available under the Edit, Create 
and Share tabs in the Editor workspace.

The Organizer just gets more powerful with each generation 
of the software and it has become, in many ways, a great little 
program on its own. We spend considerable time getting to know 
this workspace and how to use it to tag, organize and retrieve your 
media files in Chapter 31, The Organizer.

The Project Bin
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The Organizer is also the key workspace for setting up and 
managing your online File Backup/Synchronization, as we discuss 
Chapter 32, Photoshop.com.

What’s new in version 8?
Photoshop Elements remains one of Adobe’s best-designed 
programs. Offering, from its earliest version, a great feature set, 
the program is loaded with exciting tools that are useful for the 
veteran as well as the novice.

There are few ground-breaking new features this time around, 
but Adobe has added a couple of new tools that add nicely to the 
program’s tool set.

Revised Full Edit workspace

Photoshop Elements has been given a bit of a face-lift in version 8, 
with a cleaner, more modern design. But the biggest change to the 
interface is the way your photo and image files are displayed in the 
Editor workspace.

In the past, when you had several photos open at once in the 
Editor they appeared, by default, as floating panels, stacked 
slightly offset on top of one another so that you could see several 
open photo files (or at least portions of them) at once.

The new interface includes an Arrange menu that offers you a 
number of ways to display several open photos in the Editor at once, 
from basic grids to over-and-under and side-by-side displays.

Your photo files can also be displayed in a “Consolidate All” 
arrangement– with one photo occupying the entire editing space 
and all other open files accessible by way of a set of tabs along the 
top of the workspace.

For a detailed discussion on how to use these new functions, see 
The Full Edit Workspace, earlier in this chapter.

The Organizer

 In a major change in the program design – and one that signals 
Adobe’s move to truly evolving Photoshop Elements and 
Premiere Elements as an integrated “suite” of programs – the 
Organizer is no longer a sub-program of Premiere Elements and 
Photoshop Elements. It now lives as its own, separate, pretty 
much independent program – behaving more than ever like 
its professional big brother, Adobe Bridge. This now gives both 
Premiere Elements and Photoshop Elements full access to the full-
featured Organizer and its tools.

We discuss how it works in detail in Chapter 31, The Organizer.

The Auto Analyzer

The Organizer’s Auto Analyzer is much more dynamic than the old 
Smart Tag Analyzer. Rather than simply examining your photos 
and image files and tagging them for basic characteristics and 
quality, the Auto Analyzer also judges the quality of your video 
and photos, offering to classify your images according to technical 
quality.

The Auto Analyzer (which is part of the Organizer’s tool set) also 
plays a key role in some of Premiere Element’s new functions. We 
discuss what it does, as well as some of its potential liabilities, in 
Chapter 31, The Organizer. 

People Recognition 

The Organizer also includes a People Recognition Tool, which 
allows you to identify individuals in your photos and save their 
names as metadata so that you can easily locate their photos. 

Additionally, based on information provided by the Auto Analyzer, 
the tool will automatically identify (or attempt to identify) these 
same people in your other photos for easy recall.

We discuss how it works in Chapter 31, The Organizer.

What’s New in Photoshop Elements 8?
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Photomerge Exposure

The excellent Photomerge tool has been expanded to include a 
Photomerge Exposure feature. Like other Photomerge tools, it 
takes the best elements from two or more photos and seamlessly 
incorporates them into one great photo.

With Photomerge Exposure, photos of similar composition and 
differing exposures (say one photo with a dark foreground and a 
well-lit background and another with a well-lit foreground and a 
dark background) are merged to create a photo in which both the 
foreground and background are perfectly lit.

You’ll find a discussion of this new tool as well as some of the other 
Photomerge functions in Chapter 12, Advanced Photo Editing 
Tools.

Recompose Tool

Have you ever shot a photo and, looking at it later, wished the 
people in it were standing closer together or that the objects in 
the shot were much more tightly composed? The Recompose Tool 
is designed to give you a second chance to position the elements 
in your pictures. 

Using some automatic functions and some that you set manually, 
this cool, new tool allows you to take a wide shot of objects or 
people too far from each other and squeeze them into a narrower, 
tighter shot – all without distorting any key elements in the photo!

We discuss this feature in greater detail and show you how to use 
it in Chapter 4, The Photoshop Elements Toolbox.

And don’t forget Premiere Elements 8!

Premiere Elements 8 has its own set of newly added features, and 
you’ll find a discussion of each of them in Chapter 16, Take a Tour 
of Premiere Elements 8.

I hope you have fun getting to know these exciting new – as well 
as the great old – features in this terrific set of programs!


